
Лабораторная работа 18. ОБРАБОТКА 

ДАННЫХ ДИСТАНЦИОННОГО 

ЗОНДИРОВАНИЯ В ПК ЕNVI 

 

Исходные данные и материалы: комплект 

космоснимков и ПК ENVI 

Задание: изучить основные возможности ПК 

ENVI, освоить интерфейс пользователя, 

научиться открывать данные дистанционного зондирования, полученные с 

различных спутников; выполнить географическую привязку изображений; 

научиться создавать мозаичные ортофотоизображения в ПК ENVI;  

выполнить классификациюс обучением на примере снимка IKONOS  и 

выполнить генерализацию результатов классификации и их векторизацию. 

 

Порядок и методика выполнения 

 

Задание 1. ОСНОВЫ РАБОТЫ В ПРОГРАММНОМ КОМПЛЕКСЕ 

ENVI 

 

Общие сведения о программе. Программный комплекс ENVIпредназначен 

для анализа мультиспектральных и гиперспектральных изображений, 

включает наиболее полный набор функций для обработки данных ДЗЗ и их 

интеграции с данными ГИС. Диапазон задач, решаемых с помощью ПК 

ENVI, достаточно широк: от ортотрансформирования и пространственной 

привязки изображения до получения необходимой информации и ее 

интеграции с данными ГИС. 

ENVI содержит спектральные библиотеки и инструментарий для 

выполнения спектрального и топографического анализов, анализа 

растительности и классификации изображений. Отличительной 

особенностью ENVI является открытая архитектура и наличие языка 

программирования IDL (InteractiveDataLanguage), с помощью которого 

можно существенно расширить функциональные возможности программы 

для решения специализированных задач, создавать собственные и 

автоматизировать существующие алгоритмы обработки данных и выполнять 

пакетную обработку данных. Открытая архитектура ENVI обеспечивает 

удобство обработки и предоставляет пользователю возможность быстро и 

просто получать необходимую информацию. ENVI 4.3 лицензирован 

большинством операторов космических данных, поэтому обеспечивает 

поддержку данных ДЗЗ, полученных со спутников: QUICKBIRD, IKONOS, 

ORBVIEW, CAR-TOSAT-1, FORMOSAT-2, RESOURSAT, SPOT, IRS, 

LANDSAT и др. Кроме того, он поддерживает широкий диапазон растровых 

и векторных форматов таких распространенных ГИС, как ArcView, ArcInfo, 

MapInfo и др. 

В ENVI версии 4.3 включена поддержка дополнительных модулей: модуля 

для создания ЦМР DEM и модуля атмосферной коррекции FLAASH. 



Модуль DEM предоставляет пользователям возможность создавать 

высокоточные ЦМР с использованием стереоизображений, полученных со 

спутников QUICKBIRD, IKONOS, ORBVIEW-3, CARTOSAT-1, ASTER, 

SPOT 1-5 для последующего ортотрансформирования, топографического 

анализа, трехмерной визуализации и создания векторных карт. 

С помощью модуля FLAASH (FastLine-of-

sightAtmosphericAnalysisofSpectralHypercubes) можно получать более 

точную информацию из изображений, полученных с любого 

мультиспектрального или гиперспектрального сенсора, регистрирующего 

электромагнитное излучение в ближнем инфракрасном диапазоне, включая 

космические аппараты вертикального или наклонного визирования. 

Для устранения влияния различных атмосферных явлений (водяного пара, 

кислорода, углекислого газа, метана, озона, молекулярного и аэрозольного 

рассеивания) используется программа переноса излучений MODTRAN, 

создающая уникальные решения для каждого изображения. FLAASH 

корректирует смешение сигналов от смежных пикселей, вызванных 

атмосферным рассеиванием, используя для этого настраиваемые 

спектральные фильтры нового типа. 

1.1. Основные этапы обработки и анализа данных дистанционного 

зондирования Земли: 

- отображение – представление данных (изображений), полученных 

непосредственно из их источника, в удобном для пользователя наглядном 

виде без потерь и искажений; 

- улучшение – изменение параметров изображения (яркость, 

контрастность, цветовой баланс, фильтрация помех и т.д.), направленное на 

улучшение его читаемости и облегчение дальнейшего анализа; 

- географическая привязка – идентификация участка земной поверхности, 

отображѐнного на изображении, и присвоение каждой точке изображения 

координат в соответствии с координатами данных точек на местности; 

- геометрическое трансформирование – приведение изображения к 

заданному масштабу и картографической проекции с устранением смещений 

из-за выполнения съѐмки с отклонением от надира, рельефа местности, 

кривизны поверхности Земли и геометрических искажений; 

- классификация – распознавание на изображении участков, 

соответствующих различным категориям объектов, и построение на этой 

основе нового (тематического) изображения, на котором объекты, 

принадлежащие к одной категории, отображаются одинаково (одним 

цветом); 

- ГИС-анализ – анализ взаимного пространственного положения 

различных объектов на изображениях и атрибутивной (описательной) 

информации о них, производимой с целью решения разнообразных 

прикладных задач; 

- подготовка отчѐта – создание качественных отчѐтных информационных 

материалов, содержащих результаты обработки и анализа данных и 

сопровождающихся необходимыми иллюстрациями, пояснениями и т.д. 



Главное меню программного комплекса ENVI представлено на рис. 18.1. 

 

 
File          отображение данных; 

Basictools    утилиты; 

Classification дешифрирование и классификация изображения; 

Transform   улучшающие преобразования; 

Filter       широкий спектр фильтров; 

Spectral      спектральный анализ; 

Map        пространственная привязка изображения; 

Vector      отображение и анализ векторных данных; 

Topographic  топографический и пространственный анализ; 

Radar      обработка и анализ радиолокационных данных;  

Window     меню управления рабочими окнами; 

Help                on-line Help. 

Рис. 18.1. Главное меню ПК ENVI 

 

Для работы с данными дистанционного зондирования Земли в 

программном комплексе ENVI используются следующие окна: Image, Scroll, 

Zoom. Их расположение представлено на рис. 18.2. 

 

 

 

 

 

 

 

 

 

 

 

 
Рис. 18.2. Расположение рабочих окон в ПК ENVI 

 

Image – главное окно работы с изображением; 

Scroll – окно полномасштабного отображения изображения; 

Zoom – окно масштабирования. 

 

1.2. Отображение данных дистанционного зондирования  

в программном комплексе ENVI 

 



В главном меню программного комплекса ENVI выбираем команду 

File>OpenImageFile(рис. 1.3) и выбираем необходимое изображение. Эта 

команда позволяет открыть изображение в любом растровом формате. 

Если необходимо открыть данные ДЗ, полученные с конкретного 

спутника и известен формат исходных данных, можно использовать 

команду File>OpenExternalFile. Далее выбирают >Landsat, SPOT, Ikonos, 

QuickBird…(рис. 18.3). 

 

 
 

Рис. 18. 3. Выбор изображения с известным  

форматом исходных данных 

 

После того как данные отобразились в окне AvailableBandsList, правой 

кнопкой мыши нажмите на имя файла и выберите из ниспадающего меню 

команду LoadTrueColors (т.е. загрузить в естественных цветах) или 

команду LoadCIR(загрузить изображение, синтезированное с 

инфракрасным каналом). 

Мультиспектральное изображение можно визуализировать вручную. Для 

правильной визуализации изображения в естественных цветах выбираем в 

окне AvailableBandsList  в строчках RGBкрасный, зеленый и синий каналы 

соответственно. Для правильной визуализации синтезированного 

изображения с использованием инфракрасного канала выбираем в окне 

AvailableBandsList в строчках RGBинфракрасный, зеленый и синий каналы 

соответственно.  

Для примера откроем изображение снимка, полученного со спутника 

QuickBird (E:\ ENVI\ Образцы ДДЗ \QuickBird\ Hurgada\ 

005541921010_01\005541921010_01_P001_MUL\005541921010_01_P001. tif). 

На рис. 18.4 на дисплее 3 загружено изображение снимка QuickBird  в 

естественных цветах, на дисплее 2  с использованием инфракрасного 

канала. 

 



 
 

Рис. 18.4. Изображение снимка со спутника QuickBird 

 

1.3. Визуализация панхроматических изображений 

 

В качестве примера рассмотрим изображение, полученное со 

спутникаQuickBird.Открываем файлЕ:\ENVI\ Образцы ДДЗ\ 

QuickBird\Hurgada\005541921010_01\005541921010_01_P001_PAN\00554192

1010_01_P001_PAN.tif).  

Данные будут отображены в окнеAvailableBandsList(рис. 1.6).Поставьте 

отметку напротив опцииGrayScaleи выделитеBahd1, далее щелкните на 

кнопкеLoadBand. Данные будут загружены в рабочие окна (рис. 18.5). 

 

 
Рис. 18.5. Визуализация панхроматических изображений 

 

Задание 2. Геопривязка изображения в программном комплексе ENVI 

 

Данные со всех спутников поставляются геопривязанные в 

международной системе координат UTM(WGS-84).  Для решения многих 



задач необходимо установить соответствие между системой координат 

исходного изображения и референцной (или местной) системой координат. 

Для этого в программном комплексе Envi существует инструмент 

Registration. Есть возможность геопривязки снимков к картографическим 

данным (карта, опорные точки) или к растровым данным (геопривязанные 

снимки, растровые карты). 

Рассмотрим регистрацию изображений с использованием растровых 

данных. 

1. На диске E:/ENVI/TutorialDataCD#1 открываем папку bldr_reg.  

ВENVI открываем следующие файлы:bldr_sp.imgиbldr_tm.img. 

Это два снимка со спутников SPOT и LANDSAT соответственно. При этом 

изображение bldr_sp.img- геопривязано (черно-белое), а изображение и 

bldr_tm.img– нет (рис. 18.6). 

 

 
Рис. 18.6. Исходные снимки с двух спутников SPOT и LANDSAT 

 

2. ВыбираемвглавномменюENVI: >MapRegistration>SelectGCPs: 

ImagetoImage. Появится таблицаImagetoImageRegistration. В ней 

указывают, в каком дисплее загружено геопривязанное изображение, а в 

каком обрабатываемое (рис. 18.7).Щелкаем на кнопке OK. 

 

 
Рис. 18.7. Окно таблицы Image to Image Registration 

 

ПоявитсятаблицаGround Control Points Selection (рис. 18.8). 



 
Рис. 18.8. Окно таблицы Ground Control Points Selection 

 

3. Следующий этап  поиск соответствующих точек на снимках. 

Найдите объект хорошо опознаваемый на обоих снимках. На 

геопривязанном изображении bldr_sp.imgв окнеZOOMпоставьте 

перекрестие курсора на этот объект. Затем найдите этот объект на снимке 

bldr_tm.img и в окне ZOOMнаведите перекрестие курсора на 

соответствующий объект. 

ЩелкнитенакнопкеAdd Points втаблицеGround Points Selection. 

Далее таким же образом найдите следующую точку,  после добавления 

третьей точки начнет работать функция Predict. Она позволяет 

автоматически переместить перекрестие курсора в область с 

соответствующим объектом, нужно лишь уточнить положение точки и 

нажатьAddPoints. 

Точки необходимо равномерно разместить по всему снимку (всего не 

менее 25 точек). 

ВыбравShowListв окнеGroundControlPointsSelection, можно просмотреть 

и редактировать точки (рис. 18.9). Необходимо, чтобы средние 

квадратические ошибки точек привязки были меньше 1 (RMSError). 

 
Рис. 18.9. Просмотр и редактирование соответствующих точек 

 

Однако, если проекции значительно различаются друг от друга, 

необходимо для преобразования проекций применить полиномы более 

высокого порядка. 

Степень полиномиального преобразования указана в строке Degree.  По  

умолчанию  1-я степень  полиномиального преобразования (т. е. поворот, 

масштабирование и сдвиг). Применять преобразования более чем 3-й 

степени не рекомендуется. 



4. Выполняем процедуру перепроецирования изображения, т.е. 

преобразования одного изображения в проекцию другого. Для этого в 

ниспадающем меню GroundControlPointsSelection выбираем 

Option>WarpFile и в открывшейся таблице со списком открытых файлов 

выбираем файл, который будет привязан (в нашем случае bldr_tm.img). 

Щелкните по кнопке OK(рис. 18.10). 

 
Рис. 18.10. Перепроецирование изображений 

 

ОткрываетсятаблицаRegistrationParameters(рис. 18.11).В ней 

необходимо выбрать метод перепроецирования изображения:Method. 

 
Рис. 18.11. Выбор метода перепроецирования 

 

RST – поворот , масштабирование, сдвиг. 

Polihomalполином n-й степени. 

Triahgulationтриангуляция  Делоне. 

Необходимо также задать метод дискредитации изображения: 

Resamplihg. 

NearestNeighboor«ближайшего соседа». 

Bilinearбилинейной интерполяции. 

Cubicкубической свертки. 

Задайте имя нового файла и сохраните изображение в своей папке. 

Полученный файл автоматически добавится в окне AvailableBandsList. 

Файл загрузить в новое окно и оценить результаты работы (рис. 18.12). 



 

 
Рис. 18.12. Геопривязанное изображение 

 

Задание 3. Создание мозаики в программном комплексе ENVI 

 

Рассмотрим создание мозаики на примере стандартных упражнений, 

расположенных на дискеE:/ENVI/TutorialDataCD#1.  

1. Открываем папку avmosaic. 

Файлы lch_01w.img и lch_02w.imgзагружаем на разные дисплеи (рис. 

18.13).  

Файл lch_02w.imgдисплей 1; 

lch_01w.img дисплей 2. 

 

 
Рис. 18.13. Исходные изображения для создания мозаики 

 

2. ВыбираемпунктменюMap>Mosaicking>Georeferenced. 

Выбираем в появившемся окнеMapBasedMosaicпункт 

менюImport>ImportFiles(рис. 18.14). 



 

 
Рис. 18.14. Окно MapBasedMosaic 

 

Выбираем в окне MosaicInputFiles файлы с входным изображением (оба 

файла), в нашем случае lch_01w.img и lch_02w.img. 

3. Появится окноMosaic. Щелкаем правой кнопкой по изображению и в 

ниспадающем меню выбираемEditEntry. В окошкеDatavalueToIgnore 

ставим 0 (ноль) (рис. 18.15). 

 

 
Рис. 18.15. Окно EditEntry 

 

Таким образом, при создании мозаики будут игнорироваться пикселы со 

значением 0 (черный свет). Верхнее изображение должно закрываться 

нижнем, как показано на рис. 18.16. 

 



 
Рис. 18.16. Окно Mosaic 

 

4. Далее переходим в окно изображения, например lch_02w.img, чтобы 

наметить линию пореза. В окне основного изображения выбираем пункт 

меню Overlay>Annotation. 

В открывшемся окне  Annotationвыбираем объект полилиния – 

Object>Poliline. Можно выбрать нужный свет и толщину (рис. 18.17). 

 

 
Рис. 18.17. Окно Annotation 

 

В окне изображения  намечаем линию пореза.  

Для того чтобы завершить редакцию, нажимаем два раза на правую кнопку 

мыши (рис. 18.18). 

 

 
Рис. 18.18. Создание линии пореза 

 

На той части, которая будет отрезаться, ставим любой символ. Для этого 

выбираем Object>Symbol(рис. 18.19). 

 



 
Рис. 18.19. Выбор отрезаемой части изображения 

 

Сохраняем созданные объекты (аннотации) в своей папке.  

Для этого выбираем пункт менюFile>SaveAnnotation. Сохраняем файл в 

своей папке с расширением *ann. 

5.Далее переходим в окно  мозаики, щелкаем по изображению правой 

кнопкой мышии в ниспадающем меню выбираемEditEntry. В 

окошкеSelectCutlineAnnotationFileвыбираем тот файл, в котором мы 

сохранили аннотации. 

Здесь можно также выбрать цветовой баланс, т.е. сглаживается или нет 

линия сшивки. 

Далее в окне MosaicвыбираемFile>Applyи задаем имя выходного файла 

(например, mosaic1). Файл сохраняем в своей папке. Открываем полученное 

изображение в новом дисплее (рис. 18.20). 

 
Рис. 18.20. Создание мозаики 

 

Задание 4. Классификация данных дистанционного зондирования в 

программном комплексе ENVI 

 

Автоматизированное дешифрирование (классификация) наиболее 

сложный этап компьютерной обработки цифровых снимков.  

При автоматизированном дешифрировании снимков одним из 

распространенных является подход на основе спектральных признаков. Он 



базируется на том, что яркость хроматических объектов (имеющих 

определенную окраску) в разных спектральных зонах не одинакова и 

характеризуется коэффициентом спектральной яркости. Таким образом, 

каждый элемент растра  пиксел  соответствует яркости объекта для 

определенной области электромагнитного спектра. Различают два метода 

классификации изображений. 

1. Классификация с обучением по эталонам. При использовании этого 

метода на основе анализа конкретного известного изображения оператор 

формирует эталонные дешифровочные признаки для объектов.  

2. Классификация без обучения (автономная классификация). В этом 

случае дополнительные данные не используются, и классы определяются по 

разнице спектральных значений объектов. 

Классификация с обучением включает следующие этапы: 

1. Выбор классов объектов. 

2. Выбор обучающих пикселов, которые представляют эти классы. 

3. Использование выбранных пикселов и алгоритмов классификации для 

определения спектральных эталонов для каждого класса. 

4. Использование алгоритма классификации для отнесения каждого 

пиксела к предварительно выделенному классу (или, возможно, к «другому» 

классу, появившемуся во время классификации). 

В ПК Envi  реализованы различные алгоритмы автоматизированной 

классификации: правило параллелепипедов (Parallelepiped); метод 

минимального спектрального расстояния (Minimum distance); 

расстояния Махаланобиса (Mahalanobis Distance); правило 

максимального правдоподобия (Maximum likelihood); метода 

спектрального угла (Spectral Angle Mapper) . 

Последовательность действий следующая: 

1. Открываем в ПК Envi трансформированный снимок E:\ ENVI\Образцы 

ДЗЗ\ ICONOS(Transform) и загружаем его на новый дисплей.  

2. ВыбираемпунктменюBasic Tools > Region of Interest > ROI Tools (рис. 

18.21). 

 

 
Рис. 18.21. Исходное трансформированное изображение 

 

В открывшемся окне ROIToolзадают тип области Rectangle 

(прямоугольник) (рис. 18.22). 

 



 
Рис. 18.22. Окно таблицы ROITool 

 

3. На изображение выбирают обучающие пикселы для объектов, которые 

безошибочно можно распознать на изображении. В окне ROITool задают 

имя класса (например, озеро)  и цвет, которым будут отображаться объекты 

данного класса после классификации (рис. 18.23). 

 

 
Рис. 18.23.Окно таблицы ROITool 

 

При выполнении данного задания обучающие пикселы выбирают в правой 

нижней части снимка (рис. 18.24). 

 

 
Рис. 18.24. Выбор обучающих пикселов 

 

4. Выбранные классы объектов сохраняют в своей папке в файле 

внутреннего формата с расширением roi. Для этого в окне ROITool 

выбирают пункт меню File>SaveROIs. 



Выделяют классы объектов, которые необходимо сохранить и задают имя 

выходного файла (например, классы объектов) (рис. 18.25). 

 

 
Рис. 18.25. Сохранение выбранных классов объектов 

 

5. Выполняют классификацию снимка в ПК ENVI с использованием 

различных алгоритмов классификации.  

 

Классификация снимка с использованием правила максимального 

правдоподобия (Maximum likelihood) 

 

6. Выбирают алгоритм классификации из пункта меню Classification 

>Supervised>Maximum likelihood (рис. 18.26). 

 

 
Рис. 18.26. Алгоритм классификации 

 

Выбирают из списка файл (рис. 18.27), для которого выполняется 

классификация - ICONOS(Transform). 

 

 
Рис. 18.27. Выбор файла 

 



В ПК ENVI можно выполнять классификацию не для всего изображения, а 

для его фрагмента. Размер фрагмента выбирают с использованием 

функцииSpatialSubset в графическом окне «SubsetbyImage» с помощью 

курсора (рис. 18.28) и нажимают OK. 

 

 
Рис. 18.28. Выбор размера фрагмента 

 

Далее в окне MaximumlikelihoodParameters задают параметры 

классификации.  

Выбирают  классы объектов в окне SelectClassesfromRegion. Задают имя 

выходного файла, где будет храниться изображение (например, 

класс_макс_правдоподобия) и задают имя файла с правилами 

классификации ( например, правила_классиф).  

Можно сохранить оба файла в оперативной памяти, для этого необходимо 

поставить отметку напротив опции Memory(рис. 18.29). 

 
Рис. 18.29. Окно Maximum likelihood Parameters 

 

Использование функции Preview позволяет выполнить предварительный 

просмотр результатов классификации (рис. 18.30). 

 



 
Рис. 18.30. Предварительный просмотр результатов классификации 

 

В окне ClassificationPreview выбираем функцию СhangeView (изменить 

вид) для просмотра результатов классификации в другой области снимка 

(рис. 18.31). 

 

 
Рис. 18.31. Просмотр результатов в другой области снимка 

 

После выбора всех параметров классификации и предварительного 

просмотра результатов нажимаем OK. 

Файл классификации автоматически добавляется в окне AvalaibleBandList 

в список открытых файлов. Для просмотра результата классификации 

изображение загружают на новый дисплей.  

На рис. 18.32 представлены результаты классификации, с использованием 

правила максимального правдоподобия (Maximum likelihood) для фрагмента 

снимка IKONOS (на дисплее 1  исходное ортотрансформированное 

изображение; на дисплее 2  результат классификации). 

 
Рис. 18.32. Результат классификации с использованием правила  

максимального правдоподобия 



Классификация снимка с использованием метода спектральногоугла 

(SpectralAngleMapper) 

 

7. Выбирают алгоритм классификации из пункта меню Classification 

>Supervised>Spectral Angle Mapper (рис. 18.33). 

 

 
Рис. 18.33. Алгоритм классификации 

 

Выбирают файл, для которого выполняется классификацияICONOS 

(Transform) и размер фрагмента с использованием функцииSpatialSubset так 

же, как в предыдущем способе классификации. Далее в окне 

EndmemberCollection: SAMвыбираем пункт меню 

Import>fromROI/EVFfrominputfile(рис. 18.34) изагружаем файл, в 

котором хранятся классы объектов (классы_объектов.roi). 

 

 
Рис. 18.34. Окно Endmember Collection: SAM 

 

ВокнеEndmember Collection: SAM выбираютSelect All инажимаютApply 

(рис. 18.35). 

 

 
Рис. 18.35. Выбор классов объектов 

 

Затем задают параметры классификации в окне 

SpectralAngelMapperparameters. С использование функции Preview 



выполняют предварительный просмотр результатов классификациис 

различными максимальными значениями спектрального угла (0,1 радиана 

(установлено по умолчанию); 0,15 радиана и 1 радиан) (рис. 18.36). 

Задают значение спектрального угла, которое дает наиболее достоверные 

результаты классификации (в данном случае рекомендуется установить 

значение, равное 1 радиану). 

 

 

 

 

 

 

 

 

 

 
Рис. 18.36. Предварительный просмотр результатов классификации 

 

Задают имя выходного файла, где будет храниться изображение 

(например, класс_спектр_угла) и задают имя файла с правилами 

классификации (например, правила_классиф1). 

На рис. 18.37 представлены результаты классификации с использованием 

метода спектрального угла. 

 

 
Рис. 18.37. Выбор классификации с использованием метода спектрального угла 

 

8. В ПК ENVI существует возможность выполнять анализ данных 

автоматизированной классификации – выполнять объединение различных 

классов, выполнять генерализацию результатов классификации, строить 

буферные зоны, а также выполнять  преобразование результатов 

классификации в векторную форму представления данных. 

Генерализация результатов классификации 

 



Выбираем пункт меню Classification>Post Classification>Clump Classes. 

(рис. 18.38). 

 
Рис. 18.38. Алгоритм классификации 

 

В окне ClassificationInputFile выбирают файл с результатами 

классификации (например, класс_спектрального _угла) и нажимают OK (рис. 

18.39). 

 

 
Рис. 18.39. Окно Classification Input File 

 

В окне ClumpParameters выбирают классы объектов и задают имя 

выходного файла (рис. 18.40).  

 
Рис. 18.40. Окно ClumpParameters 

 

Загружают изображение на новый дисплей и визуально оценивают 

результаты (рис. 18.41). 

 



 
Рис. 18.41. Результаты генерализации 

 

На дисплее 3 (слева) представлен файл с результатами генерализации, на 

дисплее 2  исходное изображение. 

Для преобразования результатов классификации в векторные слои 

выбираемпунктменюClassification>Post Classification>Classification to 

Vector (рис. 18.42). 

 

 
Рис. 18.42. Алгоритм классификации 

 

В окне RastertoVectorinputBand выбираем из списка файл с результатами 

генерализации и нажимаем OK(рис. 18.43). 

 

 
Рис. 18.43. Окно Raster to Vector input Band  

 

В окне RastertoVectorsParameters выделяем необходимые классы 

объектов,  выбираем команду при которой каждый класс будет отображаться 

отдельным векторным слоем и задаем имя выходного файла (рис. 18.44). 

 



 
Рис. 18.44. Окно Raster to Vectors Parameters  

 

ВпоявившемсяокнеAvailable Vectors List выделяемвсеслоиинажимаем 

Load Selected. Затем в окне LoadVectorsвыбираем дисплей с исходным 

трансформированным изображением (рис. 18.45). 

 

 
Рис. 18.45. Окно AvailableVectorsList 

 

Векторные слои, созданные в результате классификации, будут 

отображены на исходном изображении снимка. Параметры отображения 

векторных слоев (цвет слоя при отображении в разных окнах, цвет текущего 

слоя) можно изменять в окне VectorParameters(рис. 18.46). 

 

 
Рис. 18.46. Результаты векторизации 

 


